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iZVleČeK
Uporaba dvofotonskega konfokalnega mikroskopa 
za raziskovanje encimske aktivnosti ektomikoriznih 
gliv in analiza slik s programom imageJ

Simbioza med ektomikoriznimi glivami in gozdnimi 
drevesi prispeva k rasti dreves in delovanju ekosistema. Ek-
tomikorizne glive so razvile visoko diferencirane strukture, 
ki omogočajo različne načine privzemanja hranilnih snovi 
in transport le teh do korenin. Aktivnost fosfataz v 
mikoriznih glivah omogoča dostopnost fosfatnih spojin v 
tleh, do katerih rastline sicer nimajo dostopa. V raziskavi 
smo analizirali aktivnost na površino hif vezane fosfataze 
(SBP) mikoriznih gliv pri sadikah bukve (Fagus sylvatica L.) 
in predstavili metodo za zajemanje in analizo slik fosfatazne 
aktivnosti. Uporabili smo dvofotonski konfokalni laserski 
mikroskop LSM 7 MP, ki omogoča zajemanje slik od 
površine mikoriznega plašča skozi mikorizni plašč vse do 
površine koreninskih celic. Koreninske vršičke smo obar-
vali s komercialnim barvilom ELF® 97. Slike smo analizirali 
s prosto dostopnim programom ImageJ. V članku smo pod-
robno opisali postopek analize in predstavili prednosti in 
slabosti izbrane metode.

Ključne besede: na površino vezana fosfataza, eksplo-
racijski tipi, fosfat, ELF® 97, bukev

abStRact
Use of twoconfocal mycroscopy for research of en
zymatic activity of ectomycorrhizal fungi and image 
analysis with imageJ program

The ectomycorrhizal symbiosis of forest trees contrib-
utes to the function of ecosystem and tree growth. The sym-
biotic organs of ectomycorrhiza (ECM) are highly differenti-
ated structures differing in nutrient uptake, transfer capaci-
ties and ability to promote tree growth. In the present study 
surface-bound phosphatase activity (SBP) was analyzed on 
ectomycorrhiza of beech seedlings (Fagus sylvatica L.). The 
method for images acquisition and their analysis was dis-
cussed. Two-photon confocal laser scanning microscope 
LSM 7 MP was used to study spatial distribution of SBP en-
zymatic activity in various thicknesses of ECM mantle in 
intact (non-sectioned) ECM root tips. ELF® 97 was used for 
staining phosphatase enzymes. Images were analyzed using 
the freely available program ImageJ. In this article, we de-
scribe in detail the analysis procedure and the advantages 
and disadvantages of the method.

Key words: surface-bound phosphatase, exploration 
types, phosphate, ELF® 97, beech
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Encimska aktivnost ektomikoriznih gliv (ECM) in nji-
hovega zunaj koreninskega micelija ima pomembno 
vlogo pri prenosu hranil iz gozdnih tal in listnega 
opada do rastline. Encimi, ki jih glive sproščajo v oko-
lico, omogočajo razgradnjo snovi, ki so vezane v tleh in 
rastlinam nedostopne (Kjøller & Struwe 2002). V 
gozdnih ekosistemih imajo glive ključno vlogo pri 
obratu, preperevanju in mineralizaciji ogljika, dušika, 
fosforja in drugih snovi, ki jih pretvorijo v obliko, ki je 
zopet dostopna rastlinam in drugi talni mikroflori 
(Ekblad s sod. 2013, Wallander s sod. 2013).

Za opazovanje encimske aktivnosti lahko izbira-
mo med nedestruktivnimi in destruktivnimi metoda-
mi. Nedestruktivne metode temeljijo na opazovanju 
encimske aktivnosti pri živih celicah. Navadno te me-
tode ne vključujejo barvanja, za opazovanje pa izbere-
mo svetlobni mikroskop (arbuskularna mikoriza), epi-
fluorescenčni mikroskop (avtofluorescenca) (Vier-
heilig, Schweiger & Brundrett 2005) ali konfokal-
ni laserski mikroskop (Schweiger s sod. 2002). De-
struktivne metode zajemajo dva tipa barvanj: vitalna 
barvanja, kjer opazovanje aktivnosti encimov temelji 
na metabolno aktivnem miceliju gliv in nevitalna bar-
vanja, kjer tehnike barvanja obarvajo tako vitalen kot 
odmrl mikorizni micelij (Vierheilig, Schweiger & 
Brundrett 2005). Nedestruktivne metode so nava-

dno bolj v uporabi pri arbuskularni mikorizi, kjer so 
korenine neobarvane in ni potrebno predhodno raz-
barvanje, medtem ko je primarna skorja in plašč ekto-
mikoriznih korenin naravno obarvan, kar zahteva 
predhodno razbarvanje korenin (Vierheilig, Schwe-
iger & Brundrett 2005). Pritsch s sodelavci (2004) 
so razvili avtomatizirano metodo z mikrotitrskimi 
ploščami, ki omogoča merjenje encimske aktivnosti 
fosfataze, hitinaze in ß-glukozidaze s spektrofotome-
trom (oz. čitalcem mikrotitrskih plošč). 

V članku bomo predstavili uporabo dvofotonskega 
konfokalnega laserskega mikroskopa LSM 7 MP, ki 
omogoča opazovanje debelih preparatov ektomikori-
znih korenin, brez predhodne priprave rezin in analizo 
slik s programom ImageJ ter prednosti oziroma slabo-
sti omenjene metode. Opazovali smo aktivnost na po-
vršino vezane fosfomonoesteraze (angl. surface bound 
phosphatase – SBP) pri različnih morfotipih ektomiko-
riznih gliv. Fosfomonoesteraze so encimi, ki razgraju-
jejo različne substrate v tleh, kot so inozitol fosfat, po-
lifosfati, mononukleotidi in fosforilirani sladkorji. 
Glede na optimum pH fosfomonoesteraz ločimo kisle 
in alkalne fosfataze (Criquet s sod. 2004). Aktivnost 
kisle fosfataze, ki smo jo preučevali, temelji na hidroli-
zi p-nitrofenil fosfata (pNPP) v p-nitrofenol fosfat 
(pNP) in fosfat (P) (Alvarez s sod. 2004).

1 UVOD

2 MATERIAL IN METODE

2.1 Vzorčenje in priprava vzorca za mik
roskopiranje

Za mikroskopiranje smo pripravili sveže vzorce miko-
riznih kratkih korenin. Vzorčili smo iz rizotronov 
(Slika 1), lončnih poskusov ali iz narave. Mikorizne 
kratke korenine smo odrezali s škarjami in jih prenesli 
v petrijevke z vodo. S korenin smo s pomočjo čopiča 
odstranili substrat in jih pripravili za barvanje. Za 
vsak vzorec smo pripravili po tri mikorizne kratke ko-
renine dolžine 3 do 4 mm. 

Protokol za pripravo mikoriznih preparatov smo 
prilagodili po Alvarez s sodelavci (2004). Za pripravo 
preparata smo uporabili fosfatazni substrat ELF® 97 
(Molecular Probes, Inc., USA) za barvanje in citrat fos-
fatni pufer za spiranje korenin po barvanju. Citrat fos-
fatni pufer smo pripravili z mešanjem 3,025 g/l Tris-
-(hidroksimetil)-aminometana, 2,9 g/l maleinske ki-
sline, 3,5 g/l citronske kisline, 1,57 g/l borove kisline in 
1 M NaOH. Pufer smo s pomočjo 1 M HCl umerili na 

pH 5. Raztopino ELF® 97 smo redčili s citrat fosfatnim 
pufrom v razmerju 10:2 v/v (pufer/ELF® 97)

2.2 barvanje mikoriznih korenin z raztopino 
elF® 97

Za vsak tip ektomikorize smo barvali po tri kratke ko-
renine (Slika 1). Za analize encimske aktivnosti fosfa-
taze pri glivah (Alvarez s sod. 2004) je v uporabi ko-
mercialni kit ELF® 97 (Johnson & Spence 2010). Kit 
vsebuje topni substrat, ki ob prisotnosti delovanja fos-
fataze fluorescira. Prednost ELF® 97 je ta, da je razlika 
med vrhovoma ekscitacijske in emisijske valovne dol-
žine približno 200 nm, kar omogoča, da lahko signal, 
ki nastane kot posledica delovanja encimov, jasno loči-
mo od signala, ki nastane kot posledica avtofluore-
scence mikoriznega micelija (Johnson & Spence 2010). 

Očiščene mikorizne korenine smo prenesli v 1,5 
ml mikrocentrifugirke in dodali 44 µl raztopine ELF® 
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97 (pH=5), 5x redčitev. Korenine smo barvali 15 minut, 
nato smo jih previdno prenesli v nove 1,5 µl mikrocen-
trifugirke, ter jih sprali s 100 µl citrat fosfatnega pufra 
(pH=5). Obarvane mikorizne korenine smo po spira-
nju prenesli na objektna stekelca s pufrom, na katera 
smo v obliki kroga nakapljali stopljen vosek v debelini 
mikoriznih korenin. Na korenine smo položili krovna 
stekelca in jih dodatno zalepili s stopljenim voskom 
vzdolž robov.

2.3 Mikroskopiranje

Mikroskopiranje smo izvajali na Inštitutu za patofizi-
ologijo v Ljubljani, v Laboratoriju za neuroendokrino-
logijo in molekularno celično fiziologijo (referenčni 
center za konfokalno mikroskopijo Carl Zeiss). Za mi-
kroskopiranje smo uporabili dvofotonski konfokalni 
mikroskop LSM 7 MP (Zeiss, Nemčija), ki je bil name-
ščen v zatemnjenem prostoru na protivibracijski mizi, 
saj lahko mehanski tresljaji in svetloba motijo meritve. 
Slike za analize (serija optičnih rezin po z-osi; ang.: Z-

-stack) smo zajemali s programsko opremo ZEN 2012 
(black edition, Release version 8.0, © Carl Zeiss Micro-
scopy GmbH 1997-2013). Razmik med rezinami je bil 
10 µm. Za vsak vzorec smo opravili tri ponovitve me-
ritev na treh različnih lokacijah na korenini.

2.4 Dvofotonski konfokalni laserski mikroskop 

Za razliko od elektronske mikroskopije (Stempak & 
Ward 1964), ki je sicer tudi zelo razširjena metoda, 
omogoča fluorescenčna mikroskopija opazovanje 
živih celic in procesov, ki potekajo v njih (Heintz-
mann & Ficz 2006, Lippincott-Schwartz & Pat-
terson 2003). Fluorescenca je pojav, pri katerem lahko 
s svetlobo primerne valovne dolžine molekulo vzbudi-
mo v višje energetsko stanje, nato pa vzbujena moleku-
la izseva foton in preide nazaj v osnovno energetsko 
stanje (Hell & Wichmann 1994). Osnova konfokal-
nega mikroskopa je fluorescenčni mikroskop (Hein-
tzmann & Ficz 2006). Konfokalni mikroskop ne 
osvetljuje celotnega vzorca hkrati, temveč ga z laser-

Slika 1: 1-vzorčenje ECM korenin iz rizotrona; 2-priprava ECM korenin za barvanje; 3-barvanje ECM korenin z ELF® 97 za 15 
minut, spiranje s citrat fosfatnim pufrom, da zaustavimo encimatsko reakcijo in prenos obarvanih koreninskih vršičkov na 
objektno stekelce, kjer smo jih pokrili s krovnim stekelcem in zalepili z voskom
Figure 1: 1-ECM roots tips were sampled from rhizotron; 2- ECM roots tips were prepared for staining; 3-ECM root tips were 
stained using ELF® 97 staining, after 15 minutes incubation they were rinsed with citrate-phosphate buffer solution in order to 
stop the enzymatic reaction and transferred to object slides and sealed with cover slides and wax 
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skim žarkom pregledujemo v določeni optični ravnini 
(Heintzmann & Ficz 2006). Vzbujeno fluorescentno 
svetlobo iz točk sprejme detektor, ki informacijo s po-
močjo računalnika pretvori v sliko. Običajni enofoton-
ski konfokalni mikroskop ima vgrajeno zaslonko, ki 
preprečuje pot svetlobe iz ozadja vzorca do detektorja 
(Földes-Papp, Demel & Tilz 2003, Wilhelm s sod. 
2014). Dvofotonski konfokalni mikroskop vzbuja mo-
lekule z dvema fotonoma daljše valovne dolžine (Denk 
s sod. 1990). Molekula mora sočasno absorbirati dva 
fotona, da preide v višje energetsko stanje, kar zagoto-
vimo z veliko gostoto fotonov, oziroma z zelo veliko 
intenziteto svetlobe (Denk s sod. 1990, Helmchen & 
Denk 2005), kar dosežemo z zbiranjem žarkov v gori-

šču in s pulznim delovanjem laserja. Posledično je in-
tenziteta svetlobe dovolj velika, da pride do vzbujanja 
fotonov le v gorišču, hkrati pa se izognemo moteči sve-
tlobi iz ozadja vzorca (Denk s sod. 1994). Ker pri dvo-
fotonskem mikroskopu vzbujamo fotone z dvakrat 
daljšo valovno dolžino, je v primerjavi z navadnim 
konfokalnim mikroskopom tudi ločljivost slike posle-
dično nekoliko manjša, medtem ko je sipanje fotonov 
manjše. Zato izbiro mikroskopa prilagodimo vzorcu: 
če je vzorec debel in se svetloba fotonov močno siplje, 
izberemo dvofotonski konfokalni mikroskop, v na-
sprotnem primeru pa enofotonski konfokalni mikro-
skop (Denk s sod. 1994). Za naše raziskave smo upora-
bili dvofotonski laserski mikroskop.

Slika 2: Izvoz slike iz programa ZEN 2011 v formatu .tif za nadaljnje analize
Figure 2: Image export from ZEN 2011 in .tif format for further analysis

3 ANALIZA SLIK S PROGRAMOM ImageJ 1.46R

Slike smo analizirali s programom ImageJ 1.46r (Nati-
onal Institutes of Health, USA). Za analizo smo slike 
najprej izvozili iz programa ZEN 2011 (Slika 2) in jih 

shranili v formatu .tif. Pri slikah smo pred izvažanjem 
izklopili kanal z belo svetlobo, ker je sicer le-ta motil 
nadaljnje analize.



Štraus, kreft & kraigher: uPOraBa DVO-fOtONskega kONfOkaLNega MikrOskOPa Za raZiskOVaNJe

69folia biologica et geologica 57/2 – 2016

Nato smo sliko odprli v programu ImageJ 1.46r, jo 
razdelili na kanale (Split channels) in zaprli vse razen 

zelenega kanala (Slika 3). Iz originalne slike smo nare-
dili dvojnike, na katerih smo nadaljevali z analizami.

3.1 analiza originala:

S funkcijo Polygon Selections smo označili celotno površino mikorizne korenine oziroma hife, ki smo jo želeli 
analizirati (Slika 4).

Slika 3: Slika originala preden smo jo razdelili na kanale (levo) in slika z izbranim zelenim kanalom pripravljena za nadaljnje 
analize (desno)
Figure 3: Original image before separating on channels (left) and selected gren channel image of the same picture ready for 
analyses (right)

Slika 4: Označevanje površine, kjer se pojavljajo aktivni encimi SBP na mikoriznem plašču z orodjem Polygon selections
Figure 4: Marking areas where active enzymes SBP were present on mycorrhizal mantle surface using tool Polygon Selections
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Ko smo nastavili parametre, smo nadaljevali z me-
ritvami: Analyze → Measure.  Pojavilo se je okno z me-
ritvami (Slika 6), ki smo jih prepisali v tabelo v MS 

Excel, ki smo jo pripravili sami. Prepisali smo podatke 
za površino (Area) in povprečno intenziteto fluore-
scence v konkretni sliki v plašču (Mean gray value).

Slika 5: Določevanje velikosti točkovne enote (piksel) (levo) in izbor želenih parametrov za analize, v našem primeru površina 
označene površine (Area) in povprečna intenziteta fluorescence v konkretni sliki v plašču (Mean gray value) (desno). Pri 
nastavitvah za analize originala odkljukamo funkcijo omejitve na nadpražno vrednost.
Figure 5: Determination of the size of the pixel unit (left) and selection of the parameters for the analysis in this case the area of 
the selected surface (Area) and the average intensity of fluorescence (Mean gray value) (right). In window Set Measurements for 
analyses of the original image tick off option Limit to threshold.

Nato smo nadaljevali z nastavitvami: Analyze → 
Set Scale…, kjer smo pri prvi postavki Distance in 
Pixels vpisali 1 in tako določili velikost točkovne enote. 
Pri nastavitvah (Set Measurements) smo za izbrana pa-
rametra izbrali površino označene površine (Area) in 

povprečno intenziteto fluorescence v konkretni sliki v 
plašču (Mean gray value). Podatek Mean gray value ima 
smisel le v sivi sliki preden določimo prag. Pri analizi 
originala odkljukamo opcijo omejitev na prag (Limit to 
Threshold) (Slika 5).

Slika 6: Okno z meritvami, ki jih prepišemo v tabelo MS Excel za nadaljnje analize.
Figure 6: Window with results of measurements, that should be copied in MS Excel 
table for further analyses.
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Po analizi originala smo nadaljevali z analizo na 
dvojnikih, kjer smo merili vrednosti pri pragu 10 %.

3.2 analiza dvojnika

Preden smo začeli z analizo, smo postavili prag: 
Image → Adjust → Threshold… (Slika 7). V odprtem 

oknu se pojavi graf in dva drsnika. Za analize premi-
kamo le zgornji drsnik, ki na nastavimo na želeno nad-
pražno vrednost vseh dimenzij, pri čemer upoštevamo 
da je slika 8-bitna. Za prag 10 % nastavimo drsnik na 
25. Nastavitev potrdimo s klikom na gumb Apply.

Nato smo kopirali označeno površino iz original-
ne slike na dvojnik: CTRL+C → Edit → Selection → 
Restore Selection 

Sledile so nastavitve za analize: Analyze → Set 

Scale… → Distance in Pixels = 1, Set Measurements…, 
kjer smo odkljukali Limit to Threshold

Pri opravljenih meritvah smo prepisali le vrednost 
za površino (Area): Analyze → Measure…

Slika 7: Nastavitev želene nadpražne vrednosti za analize.
Figure 7:  Setting of threshold value for analyses.

4 RAZPRAVA

Encimsko aktivnost lahko ugotavljamo s pomočjo bar-
vil, ki temeljijo na fluorescenci. Za ta namen so v upo-
rabi komercialno dostopni kiti (Johnson & Spence 
2010). Za analize encimske aktivnosti fosfataze pri gli-
vah (Alvarez s sod. 2004, 2012) je v uporabi komerci-
alni kit ELF® 97 (Johnson & Spence 2010). Kit vsebuje 
topni substrat, ki ob prisotnosti delovanja fosfataze 
proizvede fotostabilen rumeno-zelen precipitat na 
strani aktivnega encima. Prednost ELF® 97 je ta, da je 
razlika med vrhovoma ekscitacijske in emisijske valov-
ne dolžine približno 180 nm, kar omogoča, da lahko 
signal, ki nastane kot posledica delovanja encimov, 
jasno ločimo od signala, ki nastane kot posledica avto-
fluorescence mikoriznega micelija (Johnson & Spence 

2010). Substrat se lahko uporablja za opazovanje živih 
celic, vendar nima možnosti prehajanja skozi celično 
steno, zato lahko opazujemo le aktivnost na površino 
vezanih encimov. Avtorji (Johnson & Spence 2010) 
protokolov navajajo, da intenziteta fluorescentnega si-
gnala fiksiranih preparatov ostaja bolj ali manj enaka 
več mesecev ali celo let, kar potrjujejo tudi naše izku-
šnje. Vierheilig, Schweiger & Brundrett (2005) 
uvrščajo ELF® 97 med vitalna barvila, saj ni potrebno 
predhodno razbarvanje korenin. V naših raziskavah 
smo opazili, da barvilo prosto prehaja do mikoriznega 
plašča, kjer koreninski vršiček ni obdan z gostimi izha-
jajočimi elementi, kot so hife, oziroma kadar je koreni-
na svetlih barv. V primeru, ko je preplet hif okrog ko-
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reninskega vršička gost, smo opazili, da je preparat 
slabše obarvan ali je obarvan le na površini in barvilo 
ni prodrlo v notranjost. Za temno obarvane korenin-
ske vršičke pa ne moremo zagotovo trditi, ali je nizek 
delež opaženih encimov posledica slabšega prodiranja 
barvila v notranjost, ali je to posledica temno obarva-
nega preparata, ki onemogoča prehod emisijske svetlo-
be. Pri uporabi ELF® 97 moramo biti pozorni na biot-
ske (število bakterij in gliv, koncentracija proteinov) in 
abiotske dejavnike (pH, temperatura, vlaga), ki lahko 
vplivajo na aktivnost encima in s tem na rezultate. 
Vpliv pH na aktivnost fosfataze je vrstno specifičen 
(Alvarez s sod. 2004; Baghel, Sharma & Pandey 
2009). Baghel, Sharma & Pandey (2009) so pri glivi 
Cantharelus tropicalis dokazali višjo aktivnost SBP pri 
40 °C in značilno nižjo aktivnost pri 35 °C. Korelacijo 
med kislo fosfatazo in temperaturo ter vlago so opazili 
tudi Criquet s sodelavci (2004) v listnem opadu. Al-
varez s sodelavci (2012) so preučevali vpliv morfoti-
pov (Paxillus involutus, Pisolithus tinctorius, Cenoco-
ccum geophilum, Descolea antartica) in vnos hranilnih 
snovi (angl. soil fertility) v tla na aktivnost kisle fosfa-
taze. Ugotovili so, da na prostorsko razporeditev kisle 
fosfataze v mikoriznem miceliju vpliva morfotip (zunaj 
koreninski micelij, mikorizni plašč in Hartigova 
mreža), medtem ko vnos snovi v tla vpliva na encim-
sko aktivnost zunaj koreninskega micelija in Hartigo-
ve mreže.

Dvofotonski konfokalni mikroskop omogoča opa-
zovanje vitalnih preparatov, poleg tega pa z njim lahko 
opazujemo debelejše preparate oziroma kar cele kore-
ninske vršičke, saj lahko optično prodremo skozi mi-
korizni plašč vse do celic korenine in zato predhodna 
priprava rezin ni potrebna. Tako prihranimo na času, 
poleg tega pa opazujemo nepoškodovan koreninski vr-
šiček v celoti, razen v že prej omenjenem primeru 
temno obarvanih mikoriznih gliv, kjer bi morali kore-

nine predhodno očistiti oziroma razbarvati (Schwei-
ger s sod. 2002, Vierheilig, Schweiger & Brun-
drett 2005). Za encimske analize so v uporabi tudi 
encimski testi na filter ploščah (Pritsch s sod. 2011), 
ki omogočajo analize različnih encimov hkrati, vendar 
imamo v tem primeru le podatek o jakosti fluorescen-
tnega signala, nimamo pa podatka o razporejanju en-
cimov v mikoriznem miceliju.

Za analize slik smo izbrali prosto dostopen pro-
gram ImageJ 1.46j, ki je v znanosti uporabljen že več 
kot 25 let, še posebej se je razširil med uporabniki za 
analize slik s področja biologije (Schneider, Rasband 
& Eliceiri 2012). ImageJ 1.46r v našem primeru na 
sliki originala izmeri površino, ki jo zasede vzorec. Re-
zultati analize predstavljajo povprečne intenzitete 
fluorescence teh površin za vsak vzorec. Pri tem je po-
trebno opozoriti, da ima analiza intenzitete fluore-
scence na originalni sliki smisel le, kadar so vsi pogoji 
med vzporedno posnetimi slikami enaki (enako bar-
vanje, enaka moč laserja, fotopomnoževalke in drugo). 
Zagotavljanje enakih pogojev je skoraj nemogoče, zato 
smo za analize izbrali kontrastne slike, kar pomeni 
merjenje površine pri določenem pragu. To nam omo-
goča tudi ponovljivost metode in primerjanje podat-
kov. Preden se odločimo, kateri prag bomo izbrali, na-
redimo vzporedne analize slik pri različnih nadpra-
žnih vrednostih in izberemo tisto nadpražno vrednost, 
ki najbolj ustrezno odstrani vsa nespecifična barvanja. 
Pri delu s programom ImageJ 1.46r smo opazili, da je 
enostaven za uporabo, da preprosto označimo površi-
no, ki jo želimo analizirati in da so meritve zelo na-
tančne. Slabosti metode, ki smo jih med uporabo opa-
zili, so, da (1) je v primeru, ko je odprtih več oken (ori-
ginal in dvojnik), potrebno vedno znova označiti na 
katero okno se nanaša ukaz oziroma meritev, (2) funk-
cija razveljavi (Undo) sicer deluje, ampak naslednja 
meritev ni več zanesljivo pravilna. 

5 ZAKLJUčKI

Metoda, ki smo jo predstavili, je nova in edinstvena 
predvsem zaradi uporabe dvofotonskega laserskega 
mikroskopa. Omogoča opazovanje encimske aktivno-
sti fosfataze in njeno razporejanje v mikoriznem mice-
liju brez uporabe rezin. Konfokalna mikroskopija je že 
bila uporabljena za opazovanje aktivnosti SBP pri 

ECM glivah (Alvarez s sod. 2004, 2012), vendar vedno 
na pripravljenih rezinah ECM korenin, ki omogoča 
ozek vpogled v zelo majhen del korenine. V prihodnje 
želimo metodo še razviti in raziskati, ali je razporeja-
nje encimov pri različnih eksploracijskih tipih poveza-
no z njihovo funkcijo v naravi. 
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Enzymatic activity could be detected by dyes based on 
fluorescence. For this purpose, the commercially avail-
able kits are applicable (Johnson & Spence 2010). Al-
varez et al. (2004, 2012) used commercial kit ELF® 97 
for analyses of surface-bound phosphatase activity. 
ELF® 97 contains a soluble ELF substrate, which forms 
an intense yellow-green-fluorescent alcohol precipitate 
at the site of phosphatase activity. ELF® 97 alcohol pre-
cipitate is separated from its excitation maximum by 
over 180 nm, so ELF 97 signal can be clearly distin-
guished from most cell and mycorrhizal mycelium au-
tofluorescence (Johnson & Spence 2010). Substrate 
can be used for observing life cells, but it can not pass 
the cell wall, so just surface bound enzymatic activity 
can be analyzed. The authors of protocols indicate, 
that ELF 97 phosphate-based staining of fixed samples 
can persist for a month to one year with little if any 
loss of signal, and this was noticed also in our experi-
ments. Vierheilig, Schweiger & Brundrett (2005) 
classified ELF 97 into vital staining techniques, be-
cause clearing of roots is not necessary. In our research, 
we noticed that the dye passes freely to the mycorrhi-
zal sheath, if the root tips are not surrounded by dense 
emanating elements such as hyphae, or if the roots are 
of light colors. In the cases in which hyphae around the 
root tips are dense, we observed that the mycorrhizal 
structures are less colored or are colored only on the 
surface, indicating the dye has not penetrated in the 
interior. For dark colored root tips we cannot definite-
ly claim whether a low percentage of the observed en-
zyme results from lower dye penetration into the inte-
rior of whether this is due to the dark-colored mycor-
rhizal mantle that prevents the emission light passing 
through. When using ELF® 97 care must be taken on 
biotic (the number of bacteria and fungi, protein con-
centration) and abiotic factors (pH, temperature, hu-
midity), which can affect the enzyme activity and thus 
also the results. The influence of pH on the phospha-
tase activity is species dependent (Alvarez et al. 2004, 
Baghel, Sharma & Pandey 2009). Baghel, Sharma 
& Pandey (2009), demonstrated higher activity of SBP 
at 40 ° C and typically a lower activity at 35 ° C for the 
fungus Cantharelus tropicalis. The correlation between 
the acid phosphatase, and the temperature and humid-
ity were also observed by Criquet et al. (2004) in the 
leaf litter. Alvarez et al. (2012) studied the influence 
of morphotypes (Paxillus involutus, Pisolithus tinctori-
us, Cenococcum geophilum, Descolea Antartica) and 
soil fertility on acid phosphatase activity. They found 

that spatial distribution of acid phosphatase in mycor-
rhizal mycelium is affected by mycorrhizal morphot-
ype (extraradical mycelium, mycorrhizal mantle and 
Hartig net), while soil fertility had a significant effect 
on the enzymatic activity in the extraradical mycelium 
and Hartig net. 

Two-photon confocal microscope allows observa-
tion of vital mycorrhizal fungi, in addition prepared 
samples can be thick, or even whole root tips can be 
observed, because the laser beam can penetrate 
through mycorrhizal mycelium layers to the root cells, 
therefore, the prior preparation of the t mycelium slic-
es is not necessary. The advantage of this microscope is 
in its time-efficiency and the possibility to observe in-
tact root tips, except for the before mentioned case of 
dark colored mycorrhizal fungi, which should be 
cleared before staining (Schweiger et al. 2002, Vier-
heilig, Schweiger & Brundrett 2005). For analysis 
of enzymatic activity enzyme assays on the filter plates 
are also in use (Pritsch et al. 2011), which enable the 
analysis of several enzymes at the same time, however, 
this tests give only information of the intensity of the 
fluorescent signal, but no information about the allo-
cation of enzymes in mycorrhizal mycelium.  

For image analysis we have selected the freely 
available program ImageJ 1.46j, which is used in sci-
ence for more than 25 years, particularly for image 
analysis in biology (Schneider, Rasband & Eliceiri 
2012). In our case, ImageJ measures the area covered 
by the sample in the original image. Results of ana-
lyzes represent the average intensity of the measured 
areas for each sample. It is important to notice, that 
analyzes of intensity on original images are suitable if 
all conditions between compared images are the same 
(the same staining, the same power of laser, photomul-
tiplier…). More reproducible and also simpler is to 
analyze the copies representing contrasted images, 
measuring the area above the threshold value. It is im-
portant to choose the threshold that most effectively 
cuts off all non-specific staining. When working with 
the program ImageJ 1.46r we noticed that it is a simple 
and intuitive program to use, that has high accuracy of 
selection and it is simple to select the measuring area. 
Disadvantages of ImageJ were (1) a click on every 
image, and for each step, is needed if more images are 
open (original and duplicates), (2) caution in the work 
order is necessary, since if the operator uses the Undo 
function it can result in wrong measurements. 

6 SUMMARy
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The method used in our study is novel because of use of 
two-photon confocal microscopy. It allows to study 
spatial distribution of SBP enzymatic activity in various 
thicknesses of ECM mantle in intact (non-sectioned) 
ECM root tips. Although confocal microscopy for ob-
servation of SBP activity in ECM was already used be-

fore (Alvarez et al. 2004, 2012), it was used only in 
sectioned ECM roots, that allowed an insight into a 
very small fraction of the ECM root. We suggest that 
two-photon confocal microscopy could prove useful in 
future to study distribution of enzymatic activity of dif-
ferent exploration types and their function in nature. 

7 CONCLUSIONS
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